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This program was developed to assist me in confirming my QSO contacts on 
amateur radio. It can interface with either the N3FJP Amateur Contact Log 
(ACL), Ham Radio Deluxe (HRD – Access and SQLite Versions), or Log for Old 
Men (Log4OM) and automatically maintain a record of QSO confirmation emails. 
The application also allows for the import of standard ADIF files from other 
loggers, annotating in its database which contacts have been sent QSL cards by 
this program. Each ADIF import is appended to the application’s database. When 
the ADIF - Amateur Data Interchange Format Use ADI logging system is selected 
on the setup screen, two additional menu items are added to the file menu: one 
for importing and one for deleting all records in the application database. If all 
records from the ADIF database are deleted, you should have another method to 
determine which contacts have already received emails. The application utilizes 
QRZ membership features to obtain the email address of your contact for the 
purpose of sending an electronic copy of your QSL card. 
 
With this release, your contacts will have the option to opt out of receiving 
QSOCardCreator cards by adding “NOQSOCC” or “NOEQSL” to the QSL 
information field on their callsign update page on QRZ. 



 
 
The program necessitates a QRZ account equipped with XML capabilities to 
retrieve email addresses. It operates optimally with either N3FJP (ACL), Ham 
Radio Deluxe (HRD), or Log4OM logging to monitor sent emails. ADIF files can 
also be utilized. The program is exclusively compatible with Windows 64-bit 
operating systems. If you fulfill the prerequisites, you can acquire the application 
by clicking the “Purchase QSOCardCreator Now” button on my website. Further 
information is available on my website, which is linked below. I create the 
background image using a template I designed in Photoshop. 
 
You have the option to design your own card for use with this application. A JPG 
file with a resolution of 1800 x 1200 at 300 dpi yields the most satisfactory 
results, particularly when borderless printing is considered. A starter.pdf file, 
serving as a template, is provided within the program directory. Each graphic 
QSO file must be accompanied by a configuration file with a .icf file extension. 
The file format is outlined later in this documentation. The configuration file 
contains the font, font size, styling, and the x, y coordinates of the contact data 
(4). The program allows for the positioning of contact data around the image, but 
the image must be present. The .icf file enables three (3) free-style text (FST) 
entries, along with settings for the font, font size, font color, and X, Y coordinates 
for the text on the image. If the FST, or any other field, is not intended to be 
printed on your image, set the X coordinates to zero (0). For instance, if your 
card uses frequency but not band, send BAND_X:0 in the image configuration 
file, and the band will not be printed. I have a template for Photoshop that I use to 
create images. If you require assistance in creating an image, please seek out a 
high-resolution public domain image and send it to me. I will create the image for 
you. While the program setup may be somewhat challenging, once it is 
operational, it becomes straightforward. Once you have installed the program on 
your machine, I can provide you with a comprehensive overview of its 
functionality. 
 
The program marks the sending of the QSO card by placing an “M” in the field 
called fldQSLConfByS in the ACL database (N3FJP). For HRD, it sets the QSL 
Sent field to “Y”, QSL Sent Date to today’s date, sets the QSL Sent Via field to 
“E” for electronic, and sets the QSL_VIA field to e-mail for users with a QRZ e-
mail or NO e-mail for those with no e-mail at QRZ. For Log4OM users, a field 
called QSOFlags is added to their database, which is used to track the sending 
of e-mails by the application. When using ADIF imports, a SQLite database will 
be created, and an A backup of the database will be moved into a directory under 
this application’s directory. Within the program, there is a checkbox to exclude all 
records of previously sent QSO cards (6). This checkbox is saved in the setup 
file, and when checked, it will only show the contacts that have not yet sent a 
card. When unchecked, all contacts are shown in the grid. Double-clicking on the 
QSOFlags cell will allow you to change it. 
 



 
 
The card menu provides a function to flag a record as unsent by pressing the F2 
key. To mark a record as unsent, you must be on that record. Therefore, the 
exclude checkbox must be unchecked for you to see it. Additionally, there is an 
option to set the sent flag of a record without sending an email by pressing the 
F3 key. The send email option on the card menu performs the same function as 
the send button on the form. The save option on the card menu creates, but does 
not send, a card by email. The One Time Test Email option intercepts outgoing 
mail and sends it instead to the email address listed in the E-Mail for test mode 
field under settings. Unlike the Test Mode checkbox, no log entries are made, 
and it is only for that single email. You can blacklist or un-blacklist a callsign on 
the Cards menu. If some contact does not want your cards, you can search for 
their callsign and then press F8. They will be added to your blacklist. You will not 
be able to send to that callsign unless you remove them from the blacklist by 
searching for them and using F9 to remove that callsign from the blacklist. You 
can view who is on the Blacklist by using F12-Blacklist or clicking on that menu 
item on the log menu. The column headers of the grid allow for sorting of the 
contacts. Click on a header once to select and again to sort. Each click will 
change between ascending and descending order. This sort order is saved to the 
settings file. 
 
The comment pull-down menu (5) enables you to override the default comment 
set in the setup screen for a specific email or until the default is reselected. The 
override comment for the standard card should not exceed 100 characters. In 
fact, depending on the card font, the comment may exceed the bounds of the 
comment area. Please verify this before sending the card. The length of the 
comment field input is controlled by the MAXCOMMENTLEN line in the ICF file, 
and defaults to 90 characters. Additionally, there is a custom choice in this pull-
down menu that will display the following form. You can type up to 
MAXCOMMENTLEN characters in the comment text box and press the Add 
button to add the text to the list. Inserting a pipe character | in the text will force a 
carriage return and have the comment on more that one line. Ensure your 
comment box can handle that extra line/lines. Selecting a line in the list and 
pressing the delete button will remove that line. Double-clicking on an item in the 
list box will populate the Comment input field and allow for editing. You can then 
press Add and delete the old item. You can reload the file and cancel the 
changes with the Reload button. The Save button makes your changes 
permanent. The Select button will change the card comment to the selected item 
and close the form. The Cancel button is in case you accidentally selected 
Custom. If you scroll to the right of the grid, you can see the loggers’ comment 
field. Double-clicking on the cell will copy it to the Windows clipboard.  
 
 
 



 
 
When Amateur Contact Log (N3FJP ACL) is open, calls are made to it, and that 
The program performs the record update, thereby avoiding any locking. When 
not open, ACL is updated just like the other loggers. For this function to work, 
N3FJP must have TCP API Enabled and use Port 1100. It is faster updating the 
records when the logger is closed. 
 
 
The data button (9) will toggle and populate the information listing (11) with the 
data downloaded from the QRZ XML service. 
 
The Select Card Image button (7) will show a list view of all the cards you have in 
the application folder, which is normally C:\Program Files\QCOCardCreator. 
Double clicking on an image will load the card.  
 
 

 
 



Selecting multiple rows in the grid and pressing the Send E-mail (F1) key will 
batch process the records. This operation is memory-intensive, so it is 
recommended to process only 50 records at a time. If your logger is open and 
actively working with FT8 or other demanding processes, the application may not 
be able to process the records. In such cases, re-select the records and attempt 
the operation again. This issue is not typically encountered if the logger is closed 
while running this application. 
 
Selecting multiple rows in the grid and pressing the Bulk Clear flag on the Tools 
menu will batch process the records. Please exercise caution when using this 
option. 
 
Selecting multiple rows in the grid and pressing the Bulk Set flag on the Tools 
menu will also batch process the records. Again, please exercise caution when 
using this option. 
 
On the Tools menu, there is an option to Save System Files. This option will 
prompt you to select a location and copy the setup configuration file, blacklist, 
and Log to a directory named QSOCardCreatorSysFileBackup in the specified 
location. 
 
The Sync DB button (8) will initiate a connection to the logging database and 
repopulate the grid with data. This functionality is compatible with all loggers, but 
it is particularly beneficial when using N3FJP, as both the logger and the program 
can be executed simultaneously. 
 
The setting screen serves as the primary interface for configuring the most 
critical aspects of the program. This file can be edited using the settings menu or 
an external editor. 
 
 
 

 
 

Notes: 

 

1. Your callsign 



2. The key provided with the purchase email. 

3. Your QRZ username, often your callsign. 

4. Your QRZ account password. 

5. The username for your email account, often your email address. (e.g., 

robertsimoneau1955@gmail.com) 

6. Your password for your email. Many SMTP servers require you to obtain a 

special app password. (e.g., Gmail and Verizon) 

7. The SMTP server for your email account. (e.g., smtp.gmail.com) 

8. Your email address for use in the “From” field of the email. 

9. The default subject for the email. The text may include application 

variables (See below). 

10. The default body text for the email. The text may include application 

variables (See below) and HTML tags such as <br /> for linefeeds. 

11. A simple HTML viewer/editor. Do “Tools/Save system files” first. 

12. The default comment for use on the card, and may include application 

variables (See below). 

13. A dropdown list of the logging program you use: 

    a. N3FJP - Amateur Contract Log 

    b. HRD - Ham Radio Deluxe 

    c. Log4OM - Log for Old Men 

    d. ADIF - Amateur Data Interchange Format 

    e. HRD v6.9  - SQLite 

14. The database file to use for the application. 

15. A button to open a file dialog to locate the database file. 

16. The email address to send mail when in test mode (See below). 

17. An image configuration file. 

18. A button to open a file dialog to locate the image configuration file. 

19. The default ADIF import folder. 

20. A button to open a file dialog to select the default ADIF folder. 

21. The N3FJP server address. 

22. The N3FJP port number. 

23. How many cards should be sent between delays? 

24. How many seconds of delay should be between groups of cards in a 

batch? This is necessary for some ISPs to prevent spam alerts. Set both 23 

and 24 to zero for no delay when using batch mode. 

25. Check the box to include contact information in the body of the email 

sent. 

26. Check the box to include a credit link to my website in the body of the 

email sent. 

27. Check the box to keep sent cards. If unchecked, the QSOCards directory 

is cleared on startup. Files are saved in the 

appdata/QSOCardCreator/QSOCards directory in your document folder. 



28. Check the box to automatically save the QRZ image as you move 

through the contact grid. Files are saved in the 

QSOCardCreator/QRZ_Images directory in your document folder. 

29. Keep History. This will create a CSV file containing all the contact 

information used. You can view this from the Tools menu.  

 

 If you want to avoid sending the same card to the same contact. If you  

 Choose Tools/View History after turning on this check box, you will get 

  A screen looking like that shown below. 

 

 
 

1. Select the checkbox to enable test mode, which will produce the following 

outcomes: 

2. All actions within the program will be logged into a file named LOG.TXT, 

which is located within the application folder, and can be viewed using the 

Logs/View menu item. 

3. The emails will be intercepted just before they are sent, and the recipient 

address will be modified to the address specified in item 14 above. 

 

 

 
**Note:** There are twenty-two (22) variables that can be utilized in The Default 
Email Body Text, Default Comment Field, Free Style Text fields, and Default 
Subject, which will be replaced during the sending of the email. They are as 
follows: 
 
<QRZCALL> - Replaced with contact’s callsign 
<QRZLNAME> - Replaced with contact’s last name 
<QRZFNAME> - Replaced with contact’s first name 
<QRZWNAME> - Replaced with contact’s first name and last name 
<QRZSTATE> - Replaced with contact’s state 



<MYCALL> - Replaced with your call 
<THEIR_PARK> - Replaced with their park (SIG_INFO) 
<YOUR_PARK> - Replaced with your park (MY_SIG_INFO) 
<THEIR_GRID> - Replaced with their grid location 
<YOUR_GRID> - Replaced with your grid location 
<COMMENT> - Replaced with the comment field from the logger 
                                  with a default length of 80. This can be overridden 
                                  by adding MAXCOMMENTLEN:XX to the bottom  
                                  of the ICF file and replacing XX with the allowed 
                                  length proportional to the size of the comment 
                                  block on your card. 
<MONTH> - Replaced with the month of contact. 
<DAY> - Replaced with the day of contact. 
<YEAR> - Replaced with the year of contact. 
<TIME> - Replaced with the time of contact. 
<BAND> - Replaced with the band of contact. 
<MODE> - Replaced with the mode of contact. 
<RSTR> - Replaced with RST received during contact. 
<RSTS> - Replaced with RST sent during contact. 
<FST1> - Replaced with FST1 from ICF File. 
<FST2> - Replaced with FST2 from ICF File. 
<FST3> - Replaced with FST3 from ICF File. 
<FREQ> - Replaced with the frequency used for contact. 
<PWR> - Replaced with the power used for contact. 
 
 
 
 
Note: Items can be combined. For instance, <QRZFNAME>, <br /> <br /> 
<QRZFNAME> Thank you for the QSO. This can be used in the email body as it 
is in HTML format. In the free-style test fields, an example would be: Thank you 
<QRZFNMANE> for your QSO card. 
 



 
 
 
Card Creation Assistance 
 
The code from the program QSOCardLayout has now been incorporated into 
QSOCardCreator. If you click the mouse anywhere on the card image, then the 
X,Y coordinates of that position will show on the Window title. 
 

 
 

 
 
Show File Locations 
 



 
 
ADIF Database Editor 
 

 
 

 
Menu Structure  
 
File 
              
Import/Append ADI file         F10  Only available if logging program is set   
                                                                 to ADIF - Amateur Data Interchange  
                                                                 Format. 
 
 



ADIF database editor   Only available if logging program is set   
                                                                 to ADIF - Amateur Data Interchange  
                                                                 Format. 
 
Clear all imported ADI records F11 Only available if logging program is set 
                                                                 to ADIF - Amateur Data Interchange 
                                                                 Format. 
Show file Locations Shows the current files in use by the 

Application. 
Exit      Exit application 
 
 
Cards 
Send E-Mail                    F1       Send an e-mail based on the row 
                                                                 selected in the grid 
Clear sent Flag   F2 Removes the e-mail sent indicator 
Set sent Flag    F3 Sets the e-mail sent indicator 
Save…    F4 Saves the current QSO card for use 
                                                                 elsewhere 
Print Card     Send card to Windows Print Utility. 
One Time Test E-Mail  F5 Intercept this one e-mail and send to 
                                                                 tester 
Manually enter email address F6 Allow input of e-mail address to send 
                                                                 current card. 
QRZ DATA    F7 Turn on showing of QRZ data.  
Add current record to blacklist F8 The highlighted record added to blacklist 
Delete current record to blacklist F9 The highlighted record removed from 
                                                                 blacklist 
 
Setup      Enters setup form 
 
Logs 
Clear    Ctrl F10 Clears the debug log (LOG.TXT)  
View    Ctrl F11 View the debug log (LOG.TXT) created  
Blacklist   Ctrl F12 Shows contents of blacklist file. 
 
Tools 
Save system files    Backup of Setup, Blacklist, Database, 
                                                                 ICF, card and Comment files.  
Restore Setup File                                   Return setup to last Save System Files                                            
Edit Message body                                  Change, load and save new msg body. 
Black list maintenance   Manually add or delete from blacklist 
Bulk set flag     Set the sent flag for multiple selected  
                                                                 records 
Bulk clear flag    Clear the sent flag for multiple selected  
                                                                 records 



View History     Shows the history file if the checkbox 
      Labeled kept history is checked. 
 
Help 
QSO Flag Legend                                   What the different codes in the 
                                                                QSOFlags mean 
Manual              Show this help file 
Check for Update    Check the website for a newest version. 
Website     Takes you to my website 
About      Show version you are running. 
 
Card image configuration file Layout 
 
IMAGEFILE:default.jpg 
CALLSIGN_PAD:12 
MONTH_PAD:2 
DAY_PAD:2 
YEAR_PAD:4 
TIME_PAD:4 
BAND_PAD:5 
MODE_PAD:12 
RST_PAD:4 
INFOFONT:Calibri 
INFOFONTSIZE:18 
INFOFONTSTYLE:BOLD 
INFOFONTCOLOR:BLACK 
CALLSIGN_X:40 
CALLSIGN_Y:800 
MONTH_X:255 
MONTH_Y:800 
DAY_X:340 
DAY_Y:800 
YEAR_X:415 
YEAR_Y:800 
TIME_X:540 
TIME_Y:800 
BAND_X:670 
BAND_Y:800 
MODE_X:790 
MODE_Y:800 
RST_X:1005 
RST_Y:800 
COMMENT_X:220 
COMMENT_Y:840 
FST1: 
FST1_X:0 



FST1_Y:0 
FST1FONT:Calibri 
FST1FONTSIZE:48 
FST1FONTSTYLE:BOLD 
FST1FONTCOLOR:YELLOW 
FST2: 
FST2_X:0 
FST2_Y:0 
FST2FONT:Calibri 
FST2FONTSIZE:18 
FST2FONTSTYLE:BOLD 
FST2FONTCOLOR:BLACK 
FST3: 
FST3_X:0 
FST3_Y:0 
FST3FONT:Calibri 
FST3FONTSIZE:18 
FST3FONTSTYLE:BOLD 
FST3FONTCOLOR:BLACK 
FREQ_X:0 
FREQ_Y:0 
PWR_X:0 
PWR_Y:0 
RSTR_X:0 
RSTR_Y:0 
THEIR_PARK_X:0 
THEIR_PARK_Y:0 
YOUR_PARK_X:0 
YOUR_PARK_Y:0 
THEIR_GRID_X:0 
THEIR_GRID_Y:0 
YOUR_GRID_X:0 
YOUR_GRID_Y:0 
MAXCOMMENTLEN:90 
G:\ 
  
This is the actual image to use 
Number to pad the callsigns to assist in centering within the box 
Number to pad the month to assist in centering within the box 
Number to pad the day to assist in centering within the box 
Number to pad the year to assist in centering within the box 
Number to pad the time to assist in centering within the box 
Number to pad the band to assist in centering within the box 
Number to pad the mode to assist in centering within the box 
Number to pad the RST data to assist in centering within the box 
Font name to use in the data section of the card 



Font size to use in the data section of the card 
Font style in the data section of the card (REGULAR, BOLD, ITALIC, or BOLD+ITALIC) 
Font color (BLACK, YELLOW, WHITE, RED, BLUE, GREEN, OR Hex RGB Color code 
(Ex. #FFFFFF for white, #000000 for Black)) 
Horizontal point position for the callsign 
Vertical point position for the callsign 
Horizontal point position for the Month 
Vertical point position for the Month 
Horizontal point position for the Day 
Vertical point position for the Day 
Horizontal point position for the Year 
Vertical point position for the Year 
Horizontal point position for the Time 
Vertical point position for the Time 
Horizontal point position for the Band 
Vertical point position for the Band 
Horizontal point position for the Mode 
Vertical point position for the Mode 
Horizontal point position for the RST 
Vertical point position for the RST 
Horizontal point position for the Comment 
Vertical point position for the Comment 
Free style Text 1 – Ignored if blank 
Horizontal point position for Free style Text 1 
Vertical point position for Free style Text 1 
Font name to use for Free style Text 1 
Font size to for Free style Text 1 
Font for Free style Text 1 (REGULAR, BOLD, ITALIC, or BOLD+ITALIC) 
Font color for Free style Text 1 (BLACK, YELLOW, WHITE, RED, BLUE, GREEN, OR 
Hex RGB Color code (Ex. #FFFFFF for white, #000000 for Black)) 
Free style Text 2 – Ignored if blank 
Horizontal point position for Free style Text 2 
Vertical point position for Free style Text 2 
Font name to use for Free style Text 2 
Font size to for Free style Text 2 
Font for Free style Text 2 (REGULAR, BOLD, ITALIC, or BOLD+ITALIC) 
Font color for Free style Text 2 (BLACK, YELLOW, WHITE, RED, BLUE, GREEN, OR 
Hex RGB Color code (Ex. #FFFFFF for white, #000000 for Black)) 
Free style Text 3 – Ignored if blank 
Horizontal point position for Free style Text 3 
Vertical point position for Free style Text 3 
Font name to use for Free style Text 3 
Font size to for Free style Text 3 
Font for Free style Text 3 (REGULAR, BOLD, ITALIC, or BOLD+ITALIC) 
Font color for Free style Text 3 (BLACK, YELLOW, WHITE, RED, BLUE, GREEN, OR 
Hex RGB Color code (Ex. #FFFFFF for white, #000000 for Black)) 



Horizontal point position for Frequency (Set X value to 0 to ignore) 
Vertical point position for Frequency 
Horizontal point position for Power (Set X value to 0 to ignore) 
Vertical point position for Power 
Horizontal point position for RST Rec’d  (Set X value to 0 to ignore) 
Vertical point position for RST Rec’d 
Horizontal point position for your POTA Park (Set X value to 0 to ignore) 
Vertical point position for your POTA Park   
Horizontal point position for Their POTA Park (Set X value to 0 to ignore) 
Vertical point position for Their POTA Park  
Maximum length of record comment allowed.  
Backup Location 
 
 
File Structure for QSOCardCreator 
 
C:\Program Files\QSOCardCreator contains the application files and usually the image 
and icf files. The programs data files are stored in the users AppData Local directory. 
 

 
 

1. Each time the application is started, a copy of the database is moved into this 

folder for safety. Note: Overwritten each time. 

2. QRZ images are saved to this folder while moving within the grid with Auto Image 

D/L checked or right clicking the image on the top right of screen. 

3. Sent cards are kept here while the application is running. Note: Folder is emptied 

on application start unless Keep Cards is checked 

4. When Save System Files is chosen on the Tools Menu, all important files are 

copied to this folder for safety. Overwritten each time. 

5. Blacklist of contacts who request not to get e-mails. 



6. The configuration file for the application. Note: Extremely important file, backed 

up with System Files is chosen on the Tools Menu. 

7. Where custom comments are stored. 

8. When in test mode all actions are recorded to this file as well as any errors with 

or without test mode selected. 

9. When you switch to ADIF in the setup file for the first time, a Sqlite database 

called QSOCardCreator.db3 is created in your appdata/QSOCardCreator folder. 

You can then rename and relocate the file and select that database in the Setup 

Database file to use field. Unlike the other Logging systems which have their 

database, one has to be created. If running in ADIF database mode this file is 

created, and you can import the ADIF file for use. 

Printing cards 
 
The secret to a nice printing card is good design work. If your printer can do borderless, 
then the components of the card will need careful placement and distance from the 
edges. The image should be 1800px by 1200px at a resolution of 300 dpi. 
 

 
 
 
Noting the illustration above, the image should fill in the center to the red lines. All text 
should remain within the green lines. Use the Starter.psd file included in the program 
directory as a template. 



 
 
Troubleshooting 
 
The most challenging aspect of setting up the application is configuring the email 
server. You must identify the appropriate SMTP client, username, and password. 
Several SMTP servers necessitate application passwords due to two-factor 
authentication. 
 
Time Warner (Twc.com): Utilize your web login username and password. 
Verizon (Fios): Use your email address and password. 
AOL (Aol.com): Use your email address and application password. Refer to 
https://help.aol.com/articles/Create-and-manage-app-password for further instructions. 
Yahoo (Mail.yahoo.com): Use your email address and application password. 
Google Mail (gmail.com): Use your full email address and web login password. Ensure 
that Google is set to “Less secure apps” under myaccount.google.com. 
Google Mail (gmail.com): With two-factor authentication enabled, use your email 
address and application password. Refer to the provided link for further details. 
 
Example: Creating and Using App Passwords (Required for Gmail) 
If you encounter a “password incorrect” error during login when using two-factor 
authentication, you can attempt to use an application password. 
 
Steps: 
1. Access your Google Account. 
2. Navigate to the Security section. 
3. Under “Signing in to Google,” locate the option for two-factor authentication. 
4. Click the right arrow next to “2 Step-Verification” and scroll down to “App Passwords.” 
5. Click the right arrow again to access the application password settings. 
6. You may need to log in to complete this process. 
 
Possible Reasons for the Absence of the Application Password Option: 
- Two-factor authentication is not configured for your account. 
- Two-factor authentication is only configured for security keys. 
- Your account is associated with a work, school, or other organization. 
- Advanced Protection has been enabled. 
In the designated box, type “QSOCardCreator” and press the “Create” button. 
You will receive a 16-character password. Select it and press “Ctrl-c” to copy it. 
Tap “Done.” 
Paste the copied password into the “Setup Screen” field labeled “E-mail password.” 
(Ensure that there are no spaces between each four characters.) 
Tip: Typically, you will only need to enter an App Password once per app or device, so 
there is no need to memorize it. 
Error 403 – Forbidden 
  
 



https://www.howtogeek.com/357785/what-is-a-403-forbidden-error-and-how-can-i-fix-it/ 
 
 
 
If you are having trouble with QRZ passwords, it is often that you are using a password 
manager and/or password generator, and there are several characters that cause 
problems in QRZ passwords. Such as those below: 
 

 
 
If you are using N3FJP ACL and get occasional errors of locked indexes during batch 
mode, in ACL go to Setting refresh rate interval, and lower the interval time. Mine is set 
to 5. 
 
Version History 
Version 1 -    For Use with N3FJP - Amateur Contact Log 
Version 2 -    Added use for HRD - Ham Radio Deluxe 
Version 3 -    Added QRZ data display 
Version 4 -    Misc. bug fixes 
Version 5 -    Added ADIF file import and use for those without the supported loggers. 
Version 5.1 - Added user requested Free Style Text variables to image configuration 
                      file. (.icf) 
Version 5.2 - Added update check and notification 
Version 5.3 - Fixed missing band field on card when using ADIF 
Version 5.4 - Added use of QRZ variables in the default comment field as requested by 
                      user. 
Version 5.5 - Allows the photos and icf files to be located in any directory on the  
                      computer, not just in the application directory. This was a user request. 
Version 5.6 - Changed to new install/update system. Now one file for both tasks, with 
                      your settings-maintained safety. 
Version 5.7 - Changed the program method of updating the Ham Radio Deluxe  
                      database. Instead of a "M" being added to COL_USER_DEFINED_8 
                      field, which is also used for antenna under the system tab, now the 
                      "N" in the COL_QSL_SENT field is changed to "Y", a date is  
                      added to COL_QSLSDATE, and a "E" for electronic is added to 
                      the COL_QSL_SENT_VIA field. The grid column header sort settings 
                      are now maintained when setup is used, or the grid is refreshed. 
Version 5.8 - Added Power and frequency to the image control file, as well as making it 
                     so that any element in the icf with a X coordinate is not printed on 

https://www.howtogeek.com/357785/what-is-a-403-forbidden-error-and-how-can-i-fix-it/


                     your card. If you use frequency and don't want band to print set 
                     BAND_X:0 
Version 5.9 - Fixed a problem with QSO Sent header for HRD during record search. 
                     Added a credits line to the message body, controlled by a check box 
                     under setup. 
Version 6.0 - Auto settings update. Now a change to the database choice or image 
                     configuration file is immediately enabled. 
Version 6.1 - User requested temporary card comment input. 
Version 6.2 - User requested RST Received data for cards. Frequency and Power 
                      entries were also added. You can open your .icf file with any text editor 
                      and add the following at the bottom of the file. Remember to leave 
                      the X values at zero (0) to avoid printing on the cards. 
Version 6.3 - User requested additional font color support. In addition to standard 
                      colors, RGB hex codes can be used for INFOFONTCOLOR, 
                      FST1FONTCOLOR, FST2FONTCOLOR and FST3FONTCOLOR 
                      in the Image Configuration File (ICF). 
Version 6.4 - Fixed problem with search function on ADI data sources. 
Version 6.5 - Speedup e-mail send process. QRZ Date List now allows you to click on 
                     one or more items and hit Ctrl key and “C” to copy to clipboard. The 
                     Temporary comment checkbox has been replaced with a dropdown 
                     containing: Default, One Time, and Temporary. 
                     1. Default, gets the comment from the setup file. 
                     2. One time, prompts for the input of a comment for use on just one 
                         mail, and returns to the default from the setup after sending the  
                         current e-mail. 
                     3. Temporary prompts from an input and uses that input in every 
                         e-mail until you choose default again, at which point it gets the 
                         comment from the setup file 
Version 6.6 - Fixed problem with card save function caused by last update. 
Version 6.7 - F5-One time test send fixed. Added a user requested Blacklist function.  
                     (F8 & F9) on the Cards menu, and F12 on the Logs menu. This was 
                     requested by a user. If some contact does not want your cards, 
                     you can search for Their callsign and then hit F8 and they will be 
                     added to your blacklist. You will not be able to send to that callsign, unless 
you remove them from the blacklist, by searching for them and using F9 to remove that 
callsign from the blacklist. You can view who is on the Blacklist by using F12-Blacklist or 
clicking on that  
                     menu item on the log menu. 
Version 6.8 - Moved setup files from the Program files directory into the users AppData 
directory. This will allow multiple user accounts on the same computer to keep Their 
settings separate. 
Version 7.0 – Added support for Logbook For Old Man (Log4OM). 
Version 7.1 - User request for on-screen visual indication of your logger being open. 
Help file clarification of why you should shut down your logger while using 
QSOCardCreator. 



Version 7.2 -  Fixed a problem with the settings screen. Somehow a media control got 
placed on the form, blocked the top two input boxes. 
Version 7.3 - Grid column header sort now saved in settings file (Double click header of 
grid to sort ascending order, click again for descending, Exclude checkbox also saved 
to settings file. 
Version 7.4 - Fixed a problem with sorting on send. 
Version 7.5 - Fixed problem with initial sort order on sort. 
Version 7.6 - This version moves the log file and blacklist file to the user’s directory to 
avoid contamination when the application is used by multiple users on the same 
computer. This allows each user to maintain separate                   configuration, 
blacklist, and log files. Because the program key is connected to the callsign, and the 
callsign prints on each e-mail, a license is required for each user. 
Version 7.7 – Added a checkbox on the setup screen to allow for the keeping of cards in 
the QSL Cards directory. Unchecked and the cards are deleted on startup. 
Version 7.8 - Batch Mode 
                     Program showing correct icon on taskbar with underline when open. 
                     Prevent multiple instances of the app running 
                     Tools menu to save system files. You select location. 
Version 7.9 - Main screen resized to fit better on small laptop displays. 
                     Include contact data was not being saved correctly   
Version 8.0  The email subject can now be set in the setup form. 
                      Ex. QSO Contact - <QRZCALL> DE N1ET 
                      The main form and settings form can now be maximized  
Version 8.1  Fixes error: Operation is not valid because it results in a reentrant call 
                    to the setcurrentcelladdresscore function. 
Version 8.2  Changes grid count display to count down from the number of records 
                     to batch during batch processing. 
                     Added version number to main form title bar. 
                     Added selected count along with grid recount count 
                     Added input counter for ADIF impor 
                     Bugs fixes 
Version 8.3  Fixed an issue with ADIF database not created correctly. 
Version 8.4  Worked on showing correct image sequence during batch process. 
                    Added user requested function to save QRZ image file by right clicking on 
                    image. 
                    Added user request for custom comments under the Comment pulldown 
                    on main screen. 
Version 8.5 Fixed error message when G-Mail max daily limit is reached (500). 
                   All error received during e-mail send are logged whether in test mode or 
not.  
                   Fixed a problem with ADIF Input with a mode of MFSK and sub mode of 
FT4. 
Version 8.6 When importing an ADIF File, Submode is used if not blank. 
                    User requested Tools/Blacklist maintenance added to allow 
                    direct input of call. 
                    Fixed bug where network loss could empty the setup file. 



Version 8.7  Fixed SSL/TLS error for Windows 7 Edge users. 
                    Lessen chance of Forbidden (403) error from QRZ 
                    Tools/Save System Files now backs up system files, database, icf,  

          and card files to users Documents file in a directory called  
          QSOCardCreatorSysFileBackup. 

                    Added Tools/Bulk set flag and Tools/Bulk clear flag to replace the separate 
                    utilities that were used to allow new users to mark old records as sent. 
Version 9.0  Speed increases in several areas 
                    Correct time on cards for Ham Radio Deluxe users 
                    Fixed DB sort order from setup file 
                    Fixed a problem with checking weather QRZ is online 
                    Increased Tools/Bulk set flag and Tools/Bulk clear flag 
                    speed 100 fold. 
                    Added <MYCALL> variable for use. 
Version 9.1  Blacklist now sorted. 
                    Reset no data panel after use 
                    Extracts Primary call from Secondary call. Example OH0/DL1FMK 
                    Would return data for DL1FMK 
Version 9.2  Log4OM – Contact data shown incorrectly in e-mail body. 
Version 9.3  The database record number is now appended to the card filename.  
                    (Ex: N1ET_20221104_00_17_10m_SSB_RecNum_7397.jpg) 
Version 10.0 Added meters “m” or “cm” to band while in ADIF mode. 
                     Maintain grid positioning when losing and re-gaining focus on the grid. 
                     Added Auto Image download option. 
                     Maintain row positioning between functions 
                     Moved scattered applications all to the users document folder in 
                     a QCOCardCreator directory. 
                     Fixed problem with Blacklist Mainteance 
Version 10.1 Font style can now be REGULAR, BOLD, ITALIC, or BOLD+ITALIC in ICF 
files. 
                     Error trapping in Test mode has been strengthened. 
                     Fixed a problem with Google drive sync and your documents folder. 
                     Changed all internal references from robertsimoneau.com to n1et.com. 
                     Made speed updates to Log4OM database access. 
Version 10.2 If power is zero or blank, it will no longer be printed in the Data content 
                     section of the message body.  
                     Avoid import of dups from ADIF, based on call, date, time, band and mode.  
                     Added Select card image button to main form, the function reads your 
                     current setup to find where you store your image files and shows them 
                     on screen. Double clicking on an image will select it’s ICF, display it 
                     and update your setup file to use that image. The only restriction is 
                     that both the JPG and ICF must have the same filename. 
                     Fixed sort error on ADIF time column. 
                     Outlook.com quota limit error trapped and displayed 
                     Added comment field to grid 
                     Locked Prikey and Callsign cells during grid scroll right 



                     If comment field is to large for grid cell, a tool tip is used to display 
                     comment. Double clicking the cell will copy it to the Windows Clipboard. 
Version 10.3 Save default ADIF import folder in setup file.  
                      Added THEIR_PARK and YOUR_PARK to dup check for allow for 
                      2fer (ADIF). 
                      Added THEIR_PARK and YOUR_PARK to ICF file for use on the card 
                      See ICF line additions above for new entries for POTA data 
                      Added <THEIRPARK> and <YOURPARK> variables 
                      Added My POTA Park and Your POTA Park to the Contact data 
                      in the message body, if not blank. 
                      Added simple HTML editor for use with the default message body text, 
                      accessible from the setup screen with a button to the right of the  
                      default message body text line.  
Version 10.4 ADIF Log users were unable to mark sent or cleared unless toggling  
                      The Exclude checkbox.  
                      Log4OM users have an empty grid when first starting up and have to  
                      toggle the Exclude checkbox.  
                      When trying to send e-mails, if a mail has already been sent, it will not 
                           resend unless you clear the sent flag. You will be notified of the 
                           number skipped.  
Version 10.5 QSOCardCreator now uses Amateur Contact Log’s (ACL by N3FJP) 
                     TCP Server with local address 127.0.0.1 and Port 1100 to direct ACL 
                     To update the records for send and unsend. This removes the record 
                     Locking problems and allows QSOCardCreator and N3FJP ACL to 
                     run at the same time. Note: The other loggers still require the  
                     Logger closed while using QSOCardCreator. I are seeking remedies. 
                     Made more OneDrive friendly 
                     Fix Freq display on card for Log4OM 
Version 10.6 Added N3FJP ACL Server address and Port number to the Setup Screen. 
                     Fixed two ACL records being marked with “M” in non-batch mode. 
                     Back to the way Version 10.4 handled OneDrive. 
                     Added QSO Flag Legend to the help menu 
                     Now the application gives an indication for why a mail was not sent 
                     vs marking the record with an “M” to remove it from the grid. An “M”  
                     means the mail was successfully sent, “1” denotes no e-mail address 
                     is available, “2” denotes the callsign is on the blacklist, while the “3” 
                     denotes the user choose to ignore the sending by using the Set Sent 
                     Flag or Bulk sent flag.  
                     Added Restore Setup File to the Tools menu. This will get you back 
                     to the setup state at last use of Save System Files. 
                     Changed Card menu item F6 Text from Send W/O QRZ address to 
                     Manually enter email address. 
                     Fixed Log4OM batch mode. 
                     Added delay capability to setup. Set Cards to send between delays, 
                     and the number of seconds for the delay. Set for 0,0 = No delay.  
Version 10.7 Added <QRZWNAME> Global of contacts First and Last name. 



                      Removed the requirement to shut down the Log4OM logger 
                      while using QSOCardCreator. 
                      Removed the requirement to shut down the ADIF logger 
                      while using QSOCardCreator. 
                      Added Global variable <COMMENT> with can be used 
                      in comments and e-mail body, basically anywhere global 
                      variables can go. This will add the contents of the record 
                      comment field from your logger. 
                      Added Maximum length field as last line of ICF.MAXCOMMENTLEN:90 
                      See help file. Defaults to 80, if line is missing 
                      Added global variable legend to help menu. 
                      Added the max comment limit to the text of all comment inputs, One Time  
                      and Temporary,  
                      Added max comment size on main screen lower right corner. 
                      Add max and current size indicators on the custom input screen. 
                      Fixed problem with Bulk Clear Flag. 
  Corrected several mis-spellings in log file. 
                      Restrict ADIF Freq output to 3 characters pass the decimal point. 
Version 11.0  Moved all data files out of the documents directory and into  
                      AppData/Local directory to permanently avoid problems with 
                      OneDrive being reinstalled on updates. Remember AppData is 
                      a hidden directory, so Explorer must be set to show hidden 
                      Files. (Only if you need to get to them). 
                      Added a restore button to the setup screen. If you have done a 
                      Save system files from the tool menu, this will get the backup.   
                      Removed the requirement to close HRD while using this application. 
                      Fixed Save System Files with OneDrive installed . 
   Fixed clear sent flag when only top record selected 
   Fixed Log4OM clear flag 
   Fixed HRD clear flag 
   Added keep history to the setup screen 
   Added View history to the tools menu. 
   System backup from the tools menu also backs up 
   The history file (CARDSENT.CSV). This file is delimited with 
   The pipe character |, and can be read into Excel 
Version 11.1  Released in BETA Only 
Version 11.2  Changed to allow user to set ADIF database location.  
                      Added Edit Message body to the tools menu. 
                      Added open, save and load from setup to e-mail body editor. 
                      Tools/Save System Files now allows you to pick backup directory 
                      Tools Restore Setup files – Gets your last backup setup file. 
   Added 13 additional GLOBALS VARIABLES from the contact 
                      and ICF Files. (See below) 
 

Note: There are twenty-two (22) variables that can be used in The Default  



Email Body Text, Default comment field, Free Style Text fields and default 
subject that will be replaced during the sending of the e-Mail. They are as 
follows: (Note: All capitals within <>) 

 
<QRZCALL> - Replaced with contact’s callsign 
<QRZLNAME> - Replaced with contact’s Lastname 
<QRZFNAME> - Replaced with contact’s Firstname 
<QRZWNAME> - Replaced with contact’s Firstname and Last name 
<QRZSTATE> - Replaced with contact’s State 
<MYCALL> -  Replaced with your call 
<THEIR_PARK> - Replaced with Their POTA Park (SIG_INFO) 
<YOUR_PARK> - Replaced with your  POTA Park (MY_SIG_INFO) 
<COMMENT> - Replaced with the comment field from the logger 
                                  with a default length of 80. This can be overridden 
                                  by adding MAXCOMMENTLEN:XX to the bottom  
                                  of the ICF file and replacing XX with the allowed 
                                  length proportional to the size of the comment 
                                  block on your card.  
<MONTH> -  Replaced with month of contact. 
<DAY> -  Replaced with day of contact. 
<YEAR> -  Replaced with year of contact. 
<TIME> -  Replaced with time of contact. 
<BAND> -  Replaced with band of contact. 
<MODE> -  Replaced with mode of contact. 
<RSTR> -  Replaced with RST received during contact. 
<RSTS> -  Replaced with RST sent during contact. 
<FST1> -  Replaced with FST1 from ICF File. 
<FST2> -  Replaced with FST2 from ICF File. 
<FST3> -  Replaced with FST3 from ICF File. 
<FREQ> -  Replaced with Frequency used for contact. 
<PWR> -  Replaced with Power used for contact. 
 
Note: Items can be combined. For Example: <QRZFNAME>, <br />   <br 
/> <QRZFNAME> thank you for the QSO. Can be used in the E-Mail Body 
as it is HTML format. In the Free Style Test fields, an example would be: 
Thank you <QRZFNMANE> for your QSO card. 

                      Fixed an ADIF file import error on callsigns from QRZ export. 
                      Fixed QRZ Image message to the correct directory. 
  Added External HTML editor to allow assistance with e-mail 
  body edit. 
  Merged in the code from QSOCardLayout. Click on the card image 
  and the X,Y coordinates will show on the form title bar. 
                      Fixed MAXCOMMENTLEN implementation.  
Version 11.3   Fixed Backup select. 
    Change dates to ISO 8601 format. 
    Stop sending email if already sent in single mode. 



    Allow different name and location for the ADIF database. 
    Fixed editor not saving if called from setup screen 
.                       Show progress while on hold during batch send. 
                        Fixed error when missing Sys Backup Location file. 
                        Added Update available message. 
                        Fixed FST1-FST3 to show even when no records. 
                        Fixed editor not saving on exit or when to setup pressed. 
                        Added Copy HTML to Clipboard button to external editor. 
                        Double clicking on QSOFlags (QSL_Sent – HRD) grid cell 
                        allows you to change the flag. 
                        Fixed FST1-FST3 being converted to upper case. 
                        Added Print Card to card menu. 
                        Added main screen resizing. 
Version 11.3.1 Maintenance release to fix record/select count. 
Version 11.4    Fixed grid sort order not being saved to setup. 
                        Added Show file locations to the File menu. 
                        Added simple ADIF editor for those using that 
                        Logger system. 
Version 11.5    Fixed error in File/Show File Locations. 
                        Removed PriKey/RecNum from File names. 
                        Removed PriKey/RecNum from contact data 
                        Updated Copyright data. 
    Removed reference to POTA in Contact data 
    Contacts can elect not to receive your cards by 
    placing NOEQSL in their QSL Info field on QRZ. 
    Users with NOEQSL with turn the QSZ DATA button text 
                        to red. 
Version 11.6   In test mode the emails will be sent to the test e-mail address 
                        But the true intended address is mentioned in the log. 
    Reworked batch mode logic. 
    Change recommended card size to 1800x1200 @ 300 for 
    Better printing results. 
    Fixed blacklist not working due to lowercase. 
    Added action date to history file. 

  Contacts can elect not to receive your cards by 
    placing NOQSOCC or NOEQSL in their QSL Info field on QRZ. 
    Users with either phrases with turn the QSZ DATA button text 
                        to red. 
Version 11.7   Parse all global variables in message body. 
               Fixed minor problem with bulk clear and set functions 
.    Smoothed out batch send movement. 
    Speed up of Bulk clear and set, particularly when logger closed, 
    Check N3FJP ACL Server if ACL is open on Sync DB. Version 
 Version 11.8   Fix for Log4OM batch mode. 
 Version 11.9   Changed sponsor image on setting screen. 
                         Added Global variables <YOUR_GRID> and <THEIR_GRID> per user 



                         request. 
                         Added <YOUR_GRID> and <THEIR_GRID> to ICF file. 
                         Added <YOUR_GRID> and <THEIR_GRID> to internal ADIF database. 
                         Increased speed of movement within grid. 
                         Removed carriage return characters from the default message body 
                         to avoid corruption of the setup file. Use <br> instead. 
Version 12.0     Added DB System for HRD SQLite Database. 
                         Fixed index error when manually setting QSOFlags.    
                         Replaced Access Database Engine 2016 with Access Database 
                         Engine 365. 
                         Fix Log4OM Prikey too large for integer, causing Bulk Set and 
                         Clear to fail. 
                         Fixed FST Styles. 
                         Adding the pipe character | to the comment text causes a carriage  
                         return and line feed. 
                         Added Horizontal scrollbar to custom comment box. 
                         Notification of Test mode when sending e-mail. 
                         Fixed card select window skipping cards with uppercase file extensions. 
             
 
                          
  
    
 


